Using Ecwid to Build an Online Store

Ecwid provides all you need for a one-stop online shop, including a built-in 'drag and drop' shopping cart, the recording of customer registration details, destination zone and shipping configuration, automatic tax adjustments for purchases from defined zones, and payment processing.

This is an overview of how to use Ecwid, using the creation of an online store that sells Xara products online as an example.

Getting Started

You can add an Ecwid store to your website by dragging the Ecwid Browser widget on to your web page in Web Designer Premium 7 page. However before adding the widget to your page, it is highly recommended that you spend some time adding and configuring your store components from within Ecwid.

1. First you have to register and create an account at Ecwid (http://www.ecwid.com/getting-started.html).
   
   Ecwid sends you a verification email informing you of your unique store ID.

2. Clink the link in the email to sign in to Ecwid.
   
   Ecwid displays your store’s dashboard, already populated with a dummy shop, customers and products.
The Ecwid Dashboard: When you first open your new store, it’s populated with example products, categories, customers and orders.

In the following steps, you can either delete these dummy products, categories, customers and orders or edit them to suit your own requirements.

In the creation of the Xara online store, we chose to delete all existing items and add new information for all of these items.

**Ecwid Dashboard**

**Widget Code**

The dashboard contains 4 different types of widget code:

**Product Browser Widget code** – Forms the basis of your store front, allowing you to display category links that open the product range within each category. Your customers can purchase a product either by clicking the Add to Bag button displayed with product details, or by dragging a product into your shopping bag (if you have included the Bag Widget code in your shop – see below).

**Bag Widget code** – Creates a shopping bag that contains the details of any items your customer wants to buy. Your customers can double click the shopping bag to view purchased items and all associated tax and shipping costs, and to proceed to checkout. Note: If you choose not to add this code to your store, customers can still purchase your products by clicking the Add to Bag button.

**Categories Tabs/Menu Widget code** – Adds tabs above or a menu beside your store front, displaying all the categories within your store.
Search Box Widget Code – Adds a search box so that customers can search your store.

Note: We recommend that you do not copy any of the code in the Dashboard yet. Instead follow the steps below that will generate new widget code that you can insert directly from Web Designer Premium. This new code will allow you to resize your Ecwid widget once it’s on your web page.

Store Summary

This panel gives quick access to your categories, products, customers and sales. At the moment only the ‘dummy’ information will be present in your store. You can either edit the remaining items or delete and create new ones (recommended).

Search Box

A quick search tool for finding orders, users and products.

Order History

The dashboard also lists your last 7 (or all if required) orders.

Create New Product or Category Shortcut

You can start adding new products or categories from the Dashboard or from the Product and Category Catalog.

You need to add some products, at least one product category and existing customer information to your Ecwid store. But before adding items to your store, you may find it helpful to configure your system settings, as some values that you specify during configuration will be required when adding products and categories.

System Settings

You can configure the following system settings:

- General
  - Store Profile, Mobile Store details, Formats & Units, Languages, Cart options, E-goods
- Zones
  - Defining destination zones
- Shipping
  - Shipping costs to your defined destination zones
- Taxes
  - Additional taxes added to each purchase, depending on destination zone
- Payment
  - Setting up payment processing and customer instructions for every method of payment
- Design
Applying a new CSS theme or editing an existing one, Defining thumbnail size

- Mail
  - Specifying an email address for notifications and editing notification content

To configure system settings:

1. Click System Settings in the upper right-hand menu.

   The System Settings - General page is displayed with the E-goods tab selected.

   You have to upgrade to paid Silver membership to use the features on this tab, which specify a time limit for E-product download links and a maximum number of download attempts. However, most of the other system settings procedures can be done for free.

General – E-goods: Ecwid silver membership allows you to specify how long a link lasts and limit how many times an e-goods product can be downloaded. As shown above, links to E-goods in the Xara store expire after 72 hours and a product can be downloaded up to 10 times.

General System Settings

Store Profile

Your store profile includes store name and company contact details including the store front URL. You can also close or open your store once it is built using the Close the Store for Maintenance button at the top of this page. If you do this, type in the IP addresses for store administrators who you would like to be able to access the store even when it’s closed.

To define your store profile:

1. Click the Store Profile tab.
2. Type in a name for your store and its URL, if you know it yet.
3. Choose a time zone from the drop-down list.
4. Type in your Google Analytics ID, if you have one. This enables Ecwid to transfer information on your store visitors and web traffic to Google Analytics.
5. Type in your company’s contact details then click Browse to upload your company logo to be used on your invoices.
6. Click Save.

**General – Store Profile:** The Xara Software Products store profile displays basic information such as name, URL, time zone and contact details

**Mobile Version**

By creating a mobile version of your store, you can make it accessible for mobile phones that don’t support modern HTML/JS technologies and ensure that search engines can find it, so your products can be listed in Google.

Ecwid automatically creates and generates a link to a mobile version of your store. However you can assign it with any custom domain or by adding a subdomain on the ecwid.com domain (Silver membership only).

**To customize your mobile store:**

1. Click the Mobile Version tab.
2. Do one of the following:
   - Enter the domain name that you would like for your mobile store and click Check Availability. Ecwid informs you if the domain name is available. If so, click Apply.
   - Click the Use My Subdomain for Mobile Version link (you have to upgrade to paid Silver membership to use this feature). Enter your subdomain (for example: mobile.yourstore.com) in the popup window. Make sure your subdomain points to the specified Ecwid IP and click Apply.
3. Click Browse and then Upload to add a company logo to your mobile store.
4. Copy and paste into the text editor at the bottom of the page the HTML code for your mobile site.
5. Click Save.

General – Mobile Version: Entering a custom domain for Xara’s mobile store

Formats & Units

This page allows you to choose date, time and number display formats, as well as currency and weight units for your store. You must have specified a currency before adding products and their associated prices.

To specify formats and units:

1. Click the Formats & Units tab.
2. Choose a time, date and number display format from the drop-down lists.
3. Choose a weight unit from the drop-down list, if this is relevant to your products.
4. Choose a currency from the drop-down list. If you need to keep track of the conversion value of one unit of your chosen currency compared to the US$, type in the currency conversion value in the box next to your chosen currency.
5. If you require a currency symbol other than the default, type in a prefix or suffix.
6. Click Save.
General – Formats & Units: Defining a currency and time, date and number display for the Xara store. All product prices in the store are to be displayed in US $.

Languages

Ecwid provides 31 enabled languages. The Languages tab allows you to enable or disable languages, and choose a default. The most appropriate of these will be automatically used to view the store depending on your customer’s browser settings. If there are no appropriate enabled languages, the customer will see the default language.

Please refer to this article for more information on translations: kb.ecwid.com/Translations.

To enable or disable languages:

1. Click the Languages tab.
   
   By default all 31 languages are enabled.

2. Click the round button next to the language you want as a default.

3. Click Disable next to a language or the Disable All button, which disables every language apart from the default.

4. Click Save.
General - Languages: All 12 languages enabled with English as the store default.

Cart

The Cart tab allows you to control a maximum or minimum number of shopping cart items, cart display and customer registration options.

To set cart options:

1. Click the Cart tab.
2. Click the check box if you would like to hide out of stock products.
3. Type in a minimum or maximum number of products, if you would like to limit the total number of shopping cart items.
4. Click the next check box to hide the Ecwid shopping bag if it’s empty.
5. Click the check box to automatically create a customer account when checking out a purchase.
6. Click the next check box to collect a customer phone number on checkout.
7. If you would like to display the shopping bag as open when a product is added, click the next check box.
8. Choose a sort order from the drop-down list for the products in the shopping bag.
9. Click Save.
General - Cart: The Xara store has chosen to display out of stock products, to not impose a minimum or maximum limit and to enforce customer registration on checkout.

Zones System Settings

Destination zones are used to define shipping rates to local and worldwide destinations.

Zones

Ecwid has already provided three destination zones: USA, the USA and Canada and the EU. If these zone definitions don’t fit your requirements, you can edit them or add your own.

How to define a destination zone:

1. Click the Zones tab directly under the top left-hand banner menu.

   The three predefined zones are displayed. Click on a zone in the left-hand list to edit or rename it.

2. Type in a new zone name to rename the existing dummy one.

3. Click the Clear List button to clear the Countries list.

4. Do one of the following:
   - Click the Add Country button then in the scrolling list click the check box next to the countries you want to include in your zone. When you’ve selected the countries you want, click Add Country to close the list.
   - Click Add Region to add all countries within a region such as a continent.

   All the countries within the region are displayed in the Countries list in the Destination Zones page.

5. Click the red cross to remove a country from the Countries list.

6. To add individual US states to a zone, click Add State and select the states you want to include from the scrolling list. Click Add State to close the list.
7. To add individual states, provinces or counties within any country to the zone, click the Add Region button above the States panel and click on the country.

   All individual states, provinces or counties within that country are displayed in the States list.

8. Click the red cross to remove a state, province or county from the States list.

   If you require more detailed destination information, type in the zip/postal codes of the areas you want in your destination zone in the Zip/Postal Codes box at the bottom of the page.

9. Click Save.

   Zones: The Xara store defined 3 destination zones: UK (built by clicking Add Country and selecting the United Kingdom and Isle of Man – shipping free); Europe (built by clicking Add Region and selecting all European Union countries, then Add Country and selecting Switzerland); and Rest of World (built by clicking Add Region and selecting All Regions, then deleting all countries already in UK and Europe).

Shipping System Settings

Shipping

The Shipping tab allows you to enable multiple shipping methods with various courier companies if you have an account, or define your own shipping costs.
How to define shipping methods:

1. Click the Shipping tab directly under the top left-hand banner menu.
   The Shipping page opens with the Carrier-calculated Methods tab selected by default.

2. If you have an account with the pre-configured courier companies shown, click the company in the left-hand list. Click the Account Details link and enter your account information.

3. Click Enable next to the courier shipping methods that you would like to use.

4. Click Save.

5. If you would like to define your own shipping rates and methods, click the User-defined Methods tab.
   Ecwid has already provided an example Free Shipping Method. You can edit this definition to add your own shipping information.

6. Type in a new name for your shipping method in the Method Name box.
7. Type in a weight limit for this method, if applicable.
8. If you want to disable this shipping method, click the Disable link in the Availability panel.
9. Click the New Charge button if you want to apply a charge to this shipping method.
10. Choose a zone that you want to apply this shipping method to from the drop-down list under Zone.
11. Type in a delivery time in days.
12. Type in a shipping rate that is one of the following:
    - Per item
    - Per order
    - A percentage charge of the item price.
13. Click Save.
14. Click the Origin Address tab to add your address. If you previously entered your company details in the General – Store Profile tab, Ecwid has automatically added your address here.

Shipping: The Xara store defined 3 shipping methods to process orders from its three destination zones: A free delivery shipping rate for deliveries to the zone ‘UK’, a rate of
$6.49 per order for deliveries to all European Union countries, and a rate of $9.49 per order for deliveries to the ’Rest of World’ zone.

Taxes System Settings

Taxes

The Taxes tab allows you to apply a tax to products either bought from customers within a specific zone (tax is applied to billing address) or shipped to specific destination zones (tax is applied to shipping address).

For example VAT currently at 20% is applied to purchases when the customer lives in the European Union (EU).

In the case of VAT which applies to billing address rather than shipping address, the tax will automatically be added to a purchase made by a customer residing in the zone you specified for the tax. In our example that would apply to purchases made from our UK zone and Europe zone.

Note: You must have already created one or more zones before adding a tax.

To add a tax:

1. Click the Taxes tab directly under the top banner menu.
2. Type in a name for the tax and ensure the check box below the tax name is enabled if you want to apply the tax to all products. If you would like some of your products to be exempt of tax, for example, if it is already included in their price, click to disable the check box. When you add a product you will then have the option of adding tax to that individual product.
3. Choose from the drop-down list whether to apply the tax to the product total or to include shipping in the taxable costs.
4. Click the check box to include the tax in the displayed product price.
5. Choose from the drop-down list whether to apply the tax to the billing address of the customer or the destination of the shipped products.

By default Ecwid has created a non-taxable ‘Other zones’ category.

6. Click the New Rate button to create a taxable zone.
7. In the drop-down list below the Zone heading, choose one of the zones you added using the Zone tab.
8. In the next box type in the tax’s percentage rate.
9. Add as many new rates as you need to apply the tax to all the required zones.
10. Click Save.
**Tax:** In the Xara store we created a VAT tax rate of 20% to be applied to products purchased by anyone living in the UK and the European Union. However, as most of our product prices include VAT anyway, we didn’t enable this tax for all products. Instead at the product level we enabled VAT to be automatically added to those products that don’t already include VAT. See Product Tax and Shipping for details on the product Tax and Shipping tab within the Products Catalog.

**Payment System Settings**

**Payment Methods**

The Payment setting allows you to create a number of different ways that your customer can pay you:

- Payment Methods – you can choose from a number of listed methods and payment processors
- Google Checkout – if you have a Google Checkout account, you can automatically process payments this way. Make sure your website integration is configured in Google Checkout Merchant Center -> Settings -> Integration.
- PayPal Express Checkout – If you obtained API credentials from PayPal for a business account, you can use your PayPal Express Checkout account to automatically process payments.

**To enable one or more payment methods:**

1. Click the Taxes tab directly under the top banner menu.
   
   The Payment Methods tab, selected by default, displays a list of payment methods and processors

2. Click the Enable link to the right of a method or payment processor.
3. Click the Instruction for Customer link under Payment Method if you want to add text to instruct the customer, then click the Apply button.
4. Click a method and drag it up or down the list to give priority to your chosen methods.
5. Click a method’s Change link to display a drop-down list from which you can choose a processor to perform the method, then click the Apply link next to the list.
6. If your processor requires account information, an Account Details dialog opens. Type in your account ID and click Save.
7. Click Save.

Payment – Payment Methods: For our store we chose the PayPal method and payment processor as one payment method, and Phone Order with instructions to call our order line as a second payment method.

Design System Settings

You can change the color scheme and styles applied to your store by creating a new CSS stylesheet to apply to your store. The Design tab also allows you to change the size of any image thumbnails of your products that you display.

To apply a new CSS stylesheet:

1. Click the Design tab directly under the top banner menu.

   The CSS Themes tab below the Design Settings heading is selected by default.

2. To create a new stylesheet from scratch, click the New CSS Theme button and type your code in the blank box.

3. To modify an existing stylesheet, click one of the themes in the list on the left (other than Standard).

4. Click the Duplicate button to create a copy.

   Editable code is displayed in the box.
5. Edit only the styles that you want to change. The remaining styles will automatically use the definitions in the copied CSS theme.
6. Click the Activate link in the Status box to apply the edited stylesheet.
7. Click Save.

Design - Custom CSS Themes: We copied the red CSS design and didn’t edit any individual styles, which all displayed the base CSS theme automatically. You could also add your own unique CSS theme by clicking New CSS Theme and copying and pasting your CSS code.

Here’s the in-built red CSS theme displayed below:

Mail System Settings
Ecwid has already provided default email text for both customer and admin notifications. You can edit both using the Mail tab.
Customer Settings

Customer notifications include:

- Password reminder
- Successful registration
- Order is completed
- Order is rejected
- Egoods download
- Order tracking number

Admin Settings

Admin notifications include:

- New order
- Order is paid
- Order payment failed
- Stock notification

To edit an email notification:

1. Click the Mail tab directly under the top banner menu.
2. Click either the Customer Notifications or Admin Notifications tab.

   By default all notifications are enabled.

3. Click the Disable link to disable a notification.
4. Click the Edit Message link to change the email text and code.
5. Click Save.
Mail – Customer Notifications: You can edit the email address from which all company emails are sent for both customer and admin notifications. For the Xara store, we made sure all notification types were enabled and kept the default message text.

Product and Category Catalog

Use the Catalog tab to:

- Add products
- Create categories
- Add products to categories

Adding a product

1. Do one of the following to add a product:
   - In the Dashboard, click the New Product link in the Create box.
   - Click the Catalog tab in the upper left of the Ecwid website.
By default the General tab of the Catalog’s Products sections is selected when you open the Catalog.

The dummy information entered by default by Ecwid is displayed, showing ten fake products in a list.

2. Click the check box next to these products and click the Delete button above the list.

3. Do one of the following:
   • Click the Import Products button and in the Import Products From dialog, choose whether to import one or more .CSV, XCart or LifeCommerce files, then specify which columns to import from the files.
   • Click the New Product button.

4. If you are creating a new product, enter a unique identifying number (SKU number), a name, a description and a price for your product. If you imported products in step 3, this information would probably have been imported alongside your products.

5. If you would like to add a product image, click the Browse button under Upload/Change Product Image, locate your image file and click the Upload button. A preview is displayed.

6. Indicate whether the product is currently available enabling or disabling availability below the price box.

7. If you only have limited stock, click the Manage link under Stock Control. In the Quantity in Stock dialog, click Limited To and type in the number of items in stock. If required, type in a
number in the ‘Send me a note when quantity in stock reaches’ box. If the Quantity in Stock information is kept up to date, Ecwid sends you an automated email when the minimum stock level amount is reached.

8. Click Save to save your product information.

9. Repeat the process to add all your products to your store.

Products Catalog – General Tab: We added products individually, rather than importing, and gave each product a unique identifier, description and photo. Prices were automatically displayed as dollars, as specified in System Settings – Formats & Units. As the price of Xara Designer Pro, the product shown above, already includes VAT tax, this was not automatically added to the price by Ecwid.

Note: Click Preview Product under the Save button to view a browser preview of any product or category in your store.

Customizing a Product

There are several steps in the customization process for each new product. The first is creating product categories and adding your products to a category.
Creating a Category

Once you have added all your products, you now need to create a category and add some products to it.

To add a category:

1. Do one of the following:
   • In the Dashboard, click the New Category link in the Create box.

   ![Create ...]

   ![New Product
   New Category
   ![New Root Category button and type in a product category name.
   4. If you would like to add a category image, click the Browse button under Upload/Change Category Image, locate your image file and click the Upload button.

   A preview is displayed.

   5. Click Save to save your category.

Adding a Product to a Category

The next step is to populate your category with products. You can add products to more than one category.
To add products to your category:

1. Select your category in the list on the left then click the Category Products tab.

   ![Categories](image1)

   **Catalog – Categories – Adding Category Products:** For the Xara store, we added our products prior to creating categories, making the process of adding products to categories a straightforward procedure that can be done from within the Categories section of the Catalog.

2. Click Add Products to display the product list.

   ![Categories](image2)
3. Select the products you want to add to the category and click Add Products.

4. Click Save to save the populated category.
5. Repeat the process to add categories and assign all of your products to each category.
Categories populated with products: The Xara store has four categories, the number of products in each are displayed in the left-hand list found in Catalog - Categories

Now that you have created categories, you can return to the Products Catalog and continue to customize your products.

Product Categories

Use this tab to add a product to more than one category, or move the product to a different category.

To edit product categories:

1. Open your product – click the Catalog tab and then click Products directly underneath.
2. Click the Back to Product List button then click on the product you want to customize in the list. The product is displayed with the General tab selected by default.
3. Click the Categories tab.
4. Click one or more category check boxes.
5. Click Save.
Catalog – Products – Categories: We added our video editing product MAGIX Movie Edit Pro 17 Plus HD to more than one category. You can also use the Categories tab to change product category.

Product Options

This section allows you to offer variations on your product, for example, different sizes or colors, or different versions of a product that may be priced differently, such as standard or deluxe.

To add product options:

1. In Catalog - Products, click the Options tab then click the New Option button.
2. Type in a title for the new option, for example, Color or Size, and choose the input method that you want your customers to use when choosing their options.
3. Click the New Selection button.

A bar of input boxes appears.
4. In the box under Title, enter the name of the option, for example, ‘Red’ for a color choice or ‘Small’ for a size.
5. Under Price Modifier, use the +/- arrows to indicate whether the option will cost more or less than the product price, and then enter the price difference in either your chosen currency or by percentage.
6. Under Dflt, click the option that you would like to appear selected by default.
7. Continue to create and edit new selections until you have entered all your product options.
8. Click Save to save your product options.

If necessary, repeat the process to add more options, for example, a size option in addition to color.

*Catalog – Products – Options: Our product Xara Designer Pro 6 has three purchase options in addition to the core product: an option that includes a 450-page comprehensive print manual; an option that includes a web/graphics template pack; and an option that includes both additional purchases of manual plus template pack.*

*Product Gallery*

The Product Galley allows you to display additional images related to your product.
To create a product gallery:

1. Click the Gallery tab then click the Upload Images button.
2. In the Upload Images dialog, click the Browse button and locate your image.
3. Click the Upload Images button.

   A preview is displayed.

4. Click Save.
5. Continue until you have added all your images for the selected product.

*Catalog – Products – Gallery: Additional images illustrating our product Xara Designer Pro 6 form a gallery that the customer can browse through when viewing product information (below).*
Product Files

The Product Files tab allows you to give your customer access to files once their order reaches the status of Chargeable or Accepted.

To create a product gallery:

1. Click the Files tab then click the Upload Files button.
   The file is displayed next to a box named Description.
2. Type in a brief description of the file (optional).
3. Click Save.
4. Continue until you have added all your files for the selected product.

Catalog – Products – Files: Our store allows the upload of the Xara Designer Pro 6 manual in PDF format after the product is purchased.

Product Tax and Shipping

If you have a tax or a shipping rate that applies to selected products only, you can apply the tax and define an individual shipping rate in the Tax and Shipping tab.

To apply a tax or shipping rate to individual products:

1. Click the Tax and Shipping tab.
2. Click the Tax box to apply one or more taxes you previously defined in Taxes System Settings.
3. In the Shipping Freight drop-down list, choose one of the following:
   - Free to apply free shipping to this product only
   - Fixed rate to apply a shipping rate to this product only. Type in a value for the rate in the box below.
Global Settings to apply a shipping rate you previously defined in Shipping System Settings

Global and Fixed Rate to apply a previously defined system rate, plus a fixed rate amount on top of it. Type in a value for the rate in the box below.

4. Click Save.

Catalog – Products – Tax and Shipping: Here we applied a previously configured tax, VAT, to Xara ScreenMaker 3D, the price of which does not include VAT. Our previously defined shipping rates apply to this product, rather than a unique shipping rate, so we chose Use Global Settings as the rate for shipping.

Product HTML Code

The HTML Code tab provides code to allow you to add an individual product to your website, rather than the Product Browser widget code which creates an entire store.

You can include the following product information:

- Image thumbnail
- Product name
- Product price
- Product options
- Add to Bag button

To add an individual product to your website:

1. Drag the ecwid-browser widget from the Ecommerce Widgets section of the Designs Gallery on to your Web Designer Premium web page.


2. Click the Ecwid link directly under the Create a Shopping Cart at Ecwid heading.

   Ecwid opens in a separate browser window.
3. When prompted, log in to Ecwid.
4. In the dashboard, click the Products link in the Store Summary.
5. Click a product in the Products Link and click the HTML Code tab for the product.
6. Copy the code provided and return to the Create New Widget window.
7. Click Insert.

Web Designer Premium displays a placeholder for your product.

Move the placeholder to the desired location on your webpage.

8. Click Preview to view.

Your product and the accompanying information that you chose to include are displayed.

If your customer clicks the Add to Bag button, product pricing and shipping information is displayed. The customer can then click the Checkout button to purchase the product.

---

Adding Your Store to Your Web Page

You have now added all the information you need to add your store to your website and to start selling. You can do this easily with Xara Web Designer Premium using the Ecwid widget.

However before you add the Ecwid widget to your webpage, you need to know:

- Your Ecwid store name
- Your Ecwid store ID number

You previously entered your store name when configuring System Settings – General – Store Profile. It should also be displayed at the top of your store in Ecwid.

To find out your store ID, scroll to the bottom of any Ecwid store page. Your Store ID is displayed in the bottom right of the webpage.
To add Ecwid to your web page:

1. Drag the ecwid-browser widget from the Ecommerce Widgets section of the Designs Gallery on to your Web Designer Premium web page.


2. Now that you have set up your store and have a store name and ID, you can skip the instructions at the top of the window. Go straight to the Product Browser Widget Code section, which explains why we recommend that you use our method of generating widget code, rather than using that initially supplied by Ecwid.

3. In the Required Fields section of the window, enter your Store ID and Store Name.
4. If you would like to customize the display in your online store, edit the default settings in the Optional Fields section.

5. When you’re done, click Generate Code and then click Insert in the Create New Widget window.

Web Designer Premium displays a placeholder for your online store.

6. Click and drag the placeholder to the location on the web page where you want it to appear.

7. To resize the store, click on the placeholder then drag on the selection handles using the Select tool. Web Designer Premium resizes the badge accordingly.

8. You may need to test using your online store to ensure it’s the right size to display your shopping bag and billing information in full when these are used/selected during the purchasing process.

9. Click Preview to view your store.

**Note:** The store name will only be displayed if you are viewing the web page in a browser that has JavaScript disabled.
Inside the Xara store: The Graphics and Web Design category displays all its products. We also added code for the shopping bag widget, category menu widget and search widget, accessible from Ecwid’s Dashboard.
Inside the Xara store: After the purchase of Xara Designer Pro 6, the shopping bag now contains one item.
Inside the Xara Store: Open the shopping bag by double clicking on it. The shopping bag now contains four purchases, and displays associated costs such as tax (VAT). Click the Checkout button to enter contact and credit card details. Alternatively, previous customers can click the Sign In link at the top right to open existing details they previously entered.

Customers

Ecwid automatically registers customer details, such as contact details and email addresses.

To view existing customer details.

1. In Ecwid, click the Customers tab in the upper left of the web page.

   The Customers list displays the default dummy customers added by Ecwid.

2. Click the red cross to delete each fake customer. Alternatively click on an existing name and email address to replace the dummy information with your customers’ details.

   When you receive a purchase from a new customer, their details will be added to this list.
3. You can filter the table to view customer details by:
   - Name
   - Email address
   - Order count or range of order counts

**Note:** You have to select the Require Customers to Create Accounts on Checkout checkbox in System Settings – General – Cart to enable automatic account creation, which automatically adds customer details to this list.

![Customers](image)

*Customers: Replace the dummy info that populates the Catalog tab by default by clicking the red cross next to a customer, or clicking on a name and email address and replacing individual customer details*

### Sales/Orders

The Sales tab automatically registers order details when a purchase takes place.

**To monitor orders:**

1. In Ecwid, click the Sales tab in the upper left of the web page.

   The Orders table displays the default dummy order details added by Ecwid.

2. Click the check box to the left of each order to select it.
3. Scroll to the bottom of the table and click the Delete Selected button.

When you receive a purchase from a new customer, product and price details of each order are added to this page.

4. You can filter the table to view order details by:
   - Order number
   - A date or range of dates
   - Customer
   - Fulfillment or payment status
   - Payment or delivery method
   - Price

Sales - Orders: We recommend that you delete the dummy order information that populates the Orders tab by default by clicking the checkbox next to an order to select it, and clicking the Delete Selected button at the bottom of the tab.

Promotions

Use the Promotions tab to generate special offer codes or ‘virtual coupons’ that customers can enter at checkout to receive a discount, such as a percentage deducted from the price or free shipping for a limited time period only.

Note: The Promotions tab is only available with Silver membership.

To create a special promotion:
1. In Ecwid, click the Promotions tab in the upper center of the web page.

   The Promotions tab displays a list of dummy coupons, each demonstrating the following types of discount:
   - A fixed number of dollars (or your chosen currency) deducted from the price
   - A percentage discount
   - Free shipping

2. To remove these dummy coupons, do one of the following:
   - Click the red cross next to a coupon to delete it.
   - Click on the coupon name to edit it.

3. To create a new special promotion or coupon, click the New Coupon button.

4. In the New box, type a name for the promotion.

5. Ecwid has automatically generated a code for your promotion. Click in the box if you want to edit it, or click the ‘Generate coupon code’ link to re-apply an applicable promotion code, if necessary.

6. In the Discount drop-down list, choose either Discount or Free Shipping.

7. Do one of the following:
   - If you are offering a fixed amount discount, enter the amount in the Time of Life box and choose the currency symbol from the adjacent drop-down list.
   - If you are offering a percentage discount, enter the percentage amount in the Time of Life box and choose the percentage symbol from the adjacent drop-down list.

8. To activate the promotion and set its duration, click the ‘today’ link to display a popup calendar and click the promotion’s start date. Then click the ‘deactivated’ link and click the promotion’s end date.

9. To limit promotion availability, click the ‘no limits’ link. In the Applicable For popup window, choose whether to restrict promotion availability to:
   - A minimum product price
   - The number of times a customer can claim a discount
   - Repeat customers only.
10. You can filter the table to view promotion details by:
   - Coupon name
   - Code
   - Discount type
   - Activation date
   - Availability status
   - Number of times the promotion has been used.

11. Click Save.

Promotions – Discount Coupons: The Xara Store’s Christmas discount offered 20% off all products for a limited time period and the New Year promotion offered free shipping on all products.